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Глава 1

ПОДГОТОВКА К РАБОТЕ 

С ВЕБ-СЕРВИСОМ GOOGLE DOCS

Облачный сервис компании Google, называемый Google Docs, пре-
доставляет пользователям возможность удаленно создавать и редакти-
ровать следующие файлы:

• Текстовые файлы с расширением TXT, DOC, DOCX, RTF, HTML, 
PDF.ODT.

• Табличные файлы с расширением XLS, XLSX, ODS.

• Файлы электронных презентаций с расширением PPT, PPTX, ODP.

• Файлы изображений с расширением JPEG, PNG, SVG.

К тому же пользователю предоставляется возможность загружать 
на сервер поставщика облачных сервисов любые файлы, размер кото-
рых не превышает 2 Гб. Общий размер загруженных файлов не должен 
превышать 10 Гб. Если вы не желаете ограничиваться дисковым про-
странством в 10 Гб, вы можете увеличить объем занимаемого дискового 
пространства, разумеется, предварительно его оплатив.

Каждый пользователь сервиса Google Docs получает в свое поль-
зование бесплатный электронный почтовый ящик Gmail, с помощью 
которого вы сможете получать и отправлять электронную корреспон-
денцию.

При помощи электронного переводчика, называемого Google- пере-
водчик, вы сможете с легкостью переводить тесты с русского языка на 
более чем 60 иностранных языков, а также производить обратную про-
цедуру.

С помощью такого инструмента, как Google-календарь, вы сможете 
планировать ваши предстоящие мероприятия. Таким образом, ни одно 
запланированное событие не ускользнет от вашего внимания.

Веб-альбомы Picasa позволят вам без лишних усилий предоставить 
общий или выборочный доступ к вашим любимым фотографиям.
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Регистрация в системе Google

Чтобы получить доступ ко всем упомянутым выше сервисам, необ-
ходимо пройти процедуру регистрации нового пользователя. Для этого 
выполните следующие действия:

1. Запустите веб-браузер.

2. В адресную строку браузера введите текст: www.google.ru

3. Нажмите клавишу Enter. Откроется главная страница сайта Google.

4. В правой верхней части сайта щелкните мышью по кнопке Вой-
ти (Sign in). Откроется новая страница обозревателя, содержащая 
ссылку на страницу регистрации.

5. В открывшейся новой странице щелкните мышью по ссылке Соз-
дайте аккаунт прямо сейчас (Create an account for free). Откроется 
веб-страница, содержащая форму для регистрации (рис. 1.1).

6. В текстовое поле Ваш электронный адрес (Your current email ad-
dress) введите желаемый адрес электронной почты. После введен-
ного адреса обязательно введите @gmail.com, в противном случае 
продолжение регистрации будет невозможно.

7. В текстовое поле Укажите пароль (Choose a password) следует вве-
сти желаемую парольную комбинацию.

�  П Р И М Е Ч А Н И Е

Ваш будущий пароль может содержать латинские буквы, цифры 
и символы. Кириллические буквы недопустимы. Для получения 
подробной информации о том, каким должен быть надежный па-
роль, щелкните мышью по ссылке Надежность пароля (Password 
strength). Если система сочтет введенный вами пароль недоста-
точно надежным, будет выведено соответствующее предупреж-
дение.

8. В текстовое поле Повторно введите пароль (Re-enter password) сле-
дует повторно ввести парольную фразу.

�  П Р И М Е Ч А Н И Е

Необходимость повторного ввода пароля позволяет убедиться 
в том, что вы запомнили введенную вами последовательность сим-
волов. Крайне важно запомнить, а лучше записать введенный вами 
пароль и сохранить его в надежном месте.
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9. Установите флажок Запомнить меня (Stay signed in), чтобы ваш 
браузер запомнил информацию о логине и пароле. Если вы же-
лаете самостоятельно вводить пароль, снимите упомянутый выше 
флажок .

Рис. 1.1. Форма для регистрации на сайте Google 

10. Установите флажок Включить службу История веб-поиска (Enable 
Web History), если сочтете это нужным. 

 Для получения информации о данной службе щелкните мышью по 
ссылке Подробнее (Learn More).

11. Чтобы сделать поисковую систему Google стартовой страницей веб-
браузера, установите флажок Сделать Google моей главной страни-
цей по умолчанию (Set Google as my default homepage).

12. В раскрывающемся списке Страна (Location) с помощью мыши 
выберите пункт Россия или любой другой. 

 Выбор страны требуется для синхронизации времени создания 
и модификации до кументов. В следующем поле вам предстоит вве-
сти так называемый CAPTCHA- код.
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�  П Р И М Е Ч А Н И Е

Слово CAPTCHA является аббревиатурой от английского (completely 
automated public Turing test to tell computers and humans apart), что 
можно перевести на русский как «автоматический тест для отличия 
компьютера от человека». Суть данного метода заключается в вы-
полнении действий, простых для человека, но крайне сложных для 
компьютера. Компьютеру сложно распознать искаженные символы, 
а человек без особого труда справится с поставленной задачей. Де-
лается это для защиты от автоматических регистраций новых поль-
зователей.

13. Для заполнений рассматриваемого нами поля введите с клавиатуры 
обозначенные символы. Регистр вводимых букв не имеет значения.

 В текстовом поле, расположенном ниже, можно ознакомиться с ли-
цензионным договором. Для прокрутки содержимого поля исполь-
зуйте колесо мыши.

14. Для завершения процедуры регистрации нового пользователя на-
жмите кнопку Я принимаю условия. Создайте мой аккаунт (I ac-
cept. Create my account).

 Если вы установили флажок Сделать Google моей главной стра-
ницей по умолчанию (Set Google as my default homepage), появится 
диалоговое окно Добавление или изменение домашней страницы 
(Add or Change Home Page) (рис. 1.2).

Рис. 1.2. Диалоговое окно Добавление или изменение домашней страницы 

 При установке переключателя в положение Использовать как един-
ственную домашнюю страницу (Use this web page as your only home 
page) ваш браузер при запуске будет открывать только страницу 
www.google.ru. При установке переключателя в положение Доба-
вить эту страницу как вкладку домашней страницы (Add this web 
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page to your only page tabs) веб-браузер при запуске будет открывать 
как уже установленную стартовую страницу, так и страницу сайта 
www.google.ru.

 Если вы выбрали в качестве названия учетной записи занятый кем-
то электронный адрес, после принятия лицензионного соглашения 
появится соответствующая надпись, выполненная в красном цвете. 
В этом случае необходимо сменить или модифицировать название 
вашего аккаунта.

 Повторно введите измененный CAPTCHA-код.

 Повторно нажмите кнопку Я принимаю условия. Создайте мой ак-
каунт (I accept. Create my account). Если система не обнаружит ни-
каких проблем, аккаунт будет создан.

 Вы будете автоматически перенаправлены в ваш почтовый ящик, 
в котором уже находится несколько новых писем. Не стоит пугаться, 
это не спам, а подтверждение успешной регистрации от администра-
ции Gmail.

 Для открытия входящего сообщения щелкните мышью по его теме. 
Сообщение будет открыто в том же окне браузера.

Для получения подробного алгоритма работы с почтовым сервисом 
Gmail обратитесь к главе № 6 настоящего руководства.

Настойка параметров учетной записи 
пользователя

Перед началом работы с облачным сервисом Google Docs необходи-
мо произвести начальную настройку учетной записи пользователя. Для 
доступа к параметрам выполните следующие действия:

1. Запустите веб-браузер.

2. В адресную строку введите следующий адрес: www.google.ru.

3. Нажмите клавишу Enter. Откроется главная страница сайта Google.

4. В верхней части веб-страницы щелкните мышью по ссылке Еще 
(More). Откроется дополнительный список ссылок.

5. Щелкните мышью по ссылке Документы (Documents). Откроется 
новая вкладка браузера, которая в последующем будет содержать 
ваши документы.
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6. Нажмите кнопку , расположенную в правом верхнем углу веб-
страницы. Откроется дополнительный список ссылок.

7. Щелкните мышью по ссылке Настройка документов (Documents 
settings). Откроется веб-страница Документы Google ⇒ Настройка 
(Google Docs ⇒ Settings) (рис. 1.3).

Рис. 1.3. Фрагмент страницы Документы Google ⇒ настройка 

8. Для выбора русского языка интерфейса веб-приложений выбери-
те в раскрывающемся списке Язык (Language) соответствующий 
пункт. Чтобы раскрыть список, щелкните мышью по кнопке .

9. В раскрывающемся списке Часовой пояс (Time zone) выберите 
пункт, соответствующий вашему географическому положению.

 Следующий пункт настройки позволяет выбрать вариант открытия 
выделенных элементов.

 Если вы желаете, чтобы каждый выделенный вами документ откры-
вался в новой вкладке браузера, установите переключатель в поло-
жение В новом окне (In a new window). Для открытия выбранно-
го документа в той же вкладке браузера установите переключатель 
в положение В текущем окне (In the current window).



Подготовка к работе с веб-сервисом Google Docs

 Пункт Обновить показатели (Bold any updated items) позволяет вы-
брать оформление модифицированных документов. При предостав-
лении совместного доступа к некоторым документам пользователи, 
обладающие такими привилегиями, могут модифицировать некото-
рые файлы. Названия видоизмененных документов будут выделены 
полужирным шрифтом.

 Для активации такого режима работы установите флажок Bold any 
updated items (Выделять полужирным обновленные элементы).

 Пункт Дисковое пространство (Storage) позволяет получить от-
чет о занимаемом вашими файлами дисковом пространстве провай-
дера.

 Для увеличения предоставленного вам дискового пространства щел-
кните мышью по ссылке Обновить хранилище (Upgrade storage). 
Напоминаем, что данная услуга является платной.

 Пункт Изменить профиль (Edit your profile) позволяет задать об-
щедоступные настройки вашей учетной записи, такие как имя, фа-
милия, пол, дата рождения, а также выбрать ваш аватар в системе 
Google.

 Пункт Настройки аккаунта Google (Google Account settings) позво-
ляет изменить следующие параметры учетной записи: пароль, пара-
метры одновременного входа с нескольких аккаунтов, а также ряд 
других настроек.

10. Для сохранения внесенных изменений нажмите кнопку Сохранить 
(Save). Для отмены изменений нажмите кнопку Отмена (Cancel).

После выполнения всех вышеописанных действий учетная запись 
в системе Google Docs готова. Вы можете приступить к созданию перво-
го документа с помощью облачного сервиса.
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РАБОТАЕМ С ТЕКСТОВЫМИ 

ДОКУМЕНТАМИ

Облачный сервис Google Docs позволяет работать с текстовыми 
файлами, созданными как с помощью рассматриваемого нами облачно-
го сервиса, так и с помощью сторонних программ.

Создаем новый документ

Для создания первого текстового документа в системе Google Docs 
выполните следующие действия:

1. Запустите веб-браузер, установленный в вашей операционной си-
стеме.

2. В адресную строку введите следующий адрес: www.google.ru

3. Нажмите клавишу Enter. Откроется главная страница сайта Google.

�  П Р И М Е Ч А Н И Е

Чтобы впоследствии переходить на вышеупомянутую страницу без 
ввода адреса, щелкните мышью по кнопке , расположенной на 
панели инструментов программы Internet Explorer. Откроется центр 
управления избранным. Нажмите кнопку Добавить в избранное 
(Add to favorites). Для перехода по созданной ссылке достаточно 
открыть центр управления избранным и выбрать мышью ссылку 
Google.

4. Щелкните мышью по ссылке Еще (More), расположенной в верхней 
части сайта. Откроется дополнительный список ссылок.

5. В открывшемся списке выберите мышью ссылку Документы (Docu-
ments). Откроется ресурс Документы Google ⇒ главная страница 
(Google Docs — Home) (рис. 2.1). Во время первого запуска, разуме-
ется, главная страница рассматриваемого нами облачного сервиса не 
будет содержать ни одного документа.
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Рис. 2.1. Сайт Документы Google ⇒ главная страница 

6. Для создания первого текстового документа щелкните мышью по 
кнопке Создать (Create new), расположенной в левом верхнем углу 
сайта.

7. В появившемся раскрывающемся списке выберите мышью пункт 
Документ (Document). Откроется новая вкладка браузера, содержа-
щая чистый документ (рис. 2.2).

8. С помощью клавиатуры введите нужный вам текст.

�  П Р И М Е Ч А Н И Е

Для копирования текста выберите команду меню Правка ⇒ Ко-

пировать (Edit ⇒ Copy) или воспользуйтесь сочетанием клавиш 
Ctrl+C. Для вставки скопированного текста выберите команду меню 
Правка ⇒ Вставить (Edit ⇒ Paste) или воспользуйтесь сочетанием 
клавиш Ctrl+V. Чтобы вырезать фрагмент текста, вызовите коман-
ду Правка ⇒ Вырезать (Edit ⇒ Cut). То же самое можно выполнить 
с помощью сочетания Ctrl+X.

9. Чтобы определить название для создаваемого документа, щелкните 
мышью по ссылке Новый документ (Untitled document), располо-
женной в верхней части сайта. Откроется диалоговое окно Переи-
меновать документ (Rename document). Данное диалоговое окно 
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можно вызвать с помощью следующей команды меню: Файл ⇒ Пе-
реименовать (File ⇒ Rename).

10. В текстовое поле Введите новое имя документа (Enter a new docu-
ment name) впишите желаемое название.

11. Нажмите кнопку OK.

Рис. 2.2. Новый текстовый документ 

 Сохранение созданного вами документа происходит автоматически, 
один раз в несколько секунд.

 Для сохранения документа вручную воспользуйтесь комбинацией 
клавиш Ctrl+S либо щелкните по ссылке Сохранить (Save now), рас-
положенной в верхней части сайта. Сохранить созданный документ 
можно с помощью следующей команды меню: Файл ⇒ Сохранить 
(File ⇒ Save now).

После создания нового файла ваша персональная страница Google 
Docs будет содержать ссылку на документ. Для повторного открытия 
щелкните мышью по нужной ссылке.

Загружаем новый документ

Облачный сервис Google Docs способен распознавать текстовые 
файлы, созданные во всех популярных приложениях, среди которых:
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• Microsoft Word любой версии.

• Блокнот Windows.

• Windows WordPad.

• OpenOffice Writer.

• Adobe Acrobat.

Список расширений, поддерживаемых текстовым редактором рас-
сматриваемого нами облачного сервиса, был приведен в главе 1.

Для загрузки личного файла на облачный сервис Google Docs вы-
полните следующие действия:

1. Запустите веб-браузер.

2. Откройте главную страницу Google.

3. Щелкните мышью по ссылке Еще (More), расположенной в верхней 
части сайта. Откроется дополнительный список ссылок.

4. Выберите ссылку Документы (Documents). Откроется ваша персо-
нальная страница Google Docs (рис. 2.3).

Рис. 2.3. Персональная главная страница Google Docs 

5. Щелкните мышью по кнопке Загрузить (Upload), расположенной 
в левой верхней части страницы. Появится раскрывающийся список .
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6. Выберите пункт Файлы (Files), откроется стандартное диалоговое 
окно Открыть (Open).

7. С помощью элементов управления диалогового окна выберите за-
гружаемый файл. Для выделения нескольких файлов нажмите 
и удерживайте клавишу Ctrl на вашей клавиатуре.

8. Нажмите кнопку Открыть (Open). Появится диалоговое окно На-
стройки загрузки (Upload settings).

 Установите флажок Преобразовывать документы, презентации, 
таблицы и рисунки в формат документов Google (Convert docu-
ments, presentations, spreadsheets, and drawings to the corresponding 
Google Docs format), если желаете конвертировать загружаемые 
файлы.

�  П Р И М Е Ч А Н И Е

Конвертацию файлов необязательно производить во время за-
грузки. Вы можете перевести загруженные файлы в формат до-
кументов Google в любое время. Следует заметить, что преоб-
разование файла необходимо для дальнейшего редактирования 
документа.

 Для выделения текста из PDF-файлов, а также файлов изображений, 
установите флажок Преобразовывать текст из PDF-файлов и изо-
бражений в формат Документов Google (Convert text from PDF and 
image files to Google documents).

9. Нажмите кнопку Начать загрузку (Start Upload).

Появится диалоговое окно Загрузка (Uploading), наглядно отра-
жающее процесс передачи файлов на сервер провайдера. По окончании 
процедуры загрузки появится сообщение с подтверждением успешной 
загрузки.

Ваша персональная страница Google Docs будет содержать ссылку 
на загруженный документ. После чего вы можете приступать к редакти-
рованию свойств файла.

Следует заметить, что вы можете значительно упростить процедуру 
загрузки файлов на сервер поставщика облачных сервисов. Для этого 
просто перетащите нужный файл в окно браузера, в котором открыта 
ваша персональная страница Google Docs.
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Если вам требуется загрузить папку с файлами, вы можете загру-
жать каждый файл в отдельности или воспользоваться следующим ал-
горитмом:

1. Откройте главную персональную страницу рассматриваемого нами 
облачного сервиса.

2. Щелкните мышью по кнопке Загрузить (Upload). Появится раскры-
вающийся список ссылок.

3. Выберите мышью пункт Папку (Folder). Откроется стандартное ди-
алоговое окно Обзор папок (Browse for folder) (рис. 2.4).

Рис. 2.4. Диалоговое окно Обзор папок 

4. С помощью элементов управления диалогового окна Обзор папок 
выберите загружаемую директорию. Нажмите кнопку OK.

 Появится знакомое вам диалоговое окно Настройки загрузки (Up-
load settings). 

 Алгоритм работы с элементами управления в данном диалоговом 
окне аналогичен ранее разобранному примеру.

5. По окончании редактирования параметров диалогового окна На-
стройки загрузки нажмите кнопку Начать загрузку (Start Upload).

 Появится диалоговое окно Загрузка (Uploading), наглядно отража-
ющее прогресс передачи данных на сервер.

По окончании передачи данных ваша персональная страница Google 
Docs будет содержать загруженную папку. Чтобы открыть папку, просто 
щелкните по ней мышью.
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